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About the Dell DR2000v Deployment Guide

1

The Dell DR2000v Deployment Guide provides instructions for deploying the Dell DR2000v, a virtual DR Series system.
This documentation contains topics that explain how to deploy the Dell DR2000v system to perform data storage
operations and manage storage and replication containers.
This guide is a quick reference guide and does not include all DR Series system deployment best practices. For
information about your specific backup solution, see the DR Series data management application best practices
whitepapers at:
http://www.dell.com/support/home/us/en/04/product-support/product/powervault-dr2000v

Other Information You May Need
WARNING: The following table lists the documentation available for the Dell DR Series systems. The documents
listed are available at dell.com/support/home by selecting your specific DR Series system (under the Dell Storage
or Powervault categories). For more information about DR Series system hardware, see the safety and regulatory
information that shipped with your DR Series system. Warranty information may be included as a separate
document.

Document

Description

Dell DR Series
System Getting
Started Guide

Provides an overview of how to set up the physical DR Series system hardware and includes
technical specifications.

Dell DR Series
System Owner's
Manual

Provides information about applicable physical DR Series system features, troubleshooting the
DR Series system, and installing or replacing the DR Series system components.

Dell DR2000v
Deployment Guide

Provides information about deploying the virtual DR Series system, DR2000v, on supported
virtual platforms.

Dell DR Series
Provides information about managing backup and replication operations using the DR Series
System Administrator system GUI.
Guide
Dell DR Series
Provides information on supported hardware and software for the DR Series systems.
System
Interoperability Guide
Dell DR Series
Provides information about managing DR Series system data backup and replication
System Command
operations using the DR Series system command line interface (CLI).
Line Reference Guide
NOTE: Always check for the latest documentation and document updates at dell.com/support/home and select
your specific DR Series system (under the Dell Storage or Powervault categories). Read any document updates
first because they often supersede information in other documents.
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NOTE: Read the release notes first because they contain the most recently documented information about
features and known issues for a specific product release.
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Getting Started

2

This chapter provides an introduction to the Dell DR2000v system, specifications, usage notes and important information
to understand the deployment process.
•

Introducing the Dell DR2000v— provides an introductory description of the Dell DR2000v.

•

Specifications and Usage Notes for the Dell DR2000v — provides important information about licensing and usage
for the DR2000v.

•

Setting up Licensing for the Dell DR2000v— provides important information about how to set up your license on the
physical DR Series system to which the DR2000v will register.

Introducing the Dell DR2000v system
The Dell DR2000v is a virtual DR series system providing backup and disaster recovery (DR) features such as,
deduplication, compression, replication and advanced data protection. This virtual appliance runs inside a virtual
machine (VM) on a VMware ESXi or Microsoft Hyper-V server. The DR2000v uses storage disks resident in the
hypervisor server on which it is loaded and requires an associated physical DR system to which it will register. The
DR2000v virtual machine (VM) template is available in various licensed capacities that can be deployed on your existing
VM infrastructure. Backup/restore performance using the DR2000v is dependent on the performance of your underlying
hardware.

Specifications and notes for using the DR2000v
This section describes special notes on usage, licensing information, GUI usage limitations, and latest driver downloads
for the Dell DR2000v system.
NOTE: For detailed information about supported virtual machine platforms and versions, platform configuration
limits, virtual infrastructure and memory requirements, and other related system information, see the Dell DR
Series System Interoperability Guide.

Virtual Tape Library
Virtual Tape Library (VTL) support is available on the DR2000v in demo mode for trial and proof of concept only. To learn
more about this functionality, contact your Dell sales representative to request a VTL demo license for the DR2000v. To
download the trial version, visit the following link: http://software.dell.com/products/dr2000v-virtual-backup-appliance/
software-downloads.aspx.

Licensing
A physical DR Series hardware system serves as a license server for the DR2000v virtual system. The DR2000v system
requires a permanent license to be installed on the DR Series hardware system to which it will authenticate. This DR
Series hardware system to which the DR2000v registers must be running the DR series system software version 3.2 (or
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later). For more information about setting up licensing, see the topic, “Setting up Licensing for the DR2000v,” in this
guide. For more information about license limits, see the Dell DR Series System Interoperability Guide.
NOTE: The DR2000v 30-day trial version does not require a license to be installed on a physical DR Series
hardware system for operation.

DR2000v Hyperscale licensing
VM Hyperscale licenses are deployed on the DR Series appliance to support and maintain multiple virtual DR2000v
appliances that are licensed by a single physical DR Series hardware system. A physical DR Series hardware system
can support up to 3,000 virtual machines.
NOTE: A DR Series hardware system with a Hyperscale license can function as a regular DR Series system.
For more information on DR2000v license limits, see the Dell DR Series System Interoperability Guide. For more
information about DR2000v Hyperscale licensing, contact your Dell sales representative or Dell support.

DR Series system GUI usage
The DR2000v system is a Global View-managed unit and is managed by the physical DR Series hardware system to
which it is registered. Refer to the following notes about GUI usage specific to the DR2000v.
•

You should not change the MTU setting for the DR2000v but should leave the setting at the system default of 1500.

•

The DR Series system GUI Usage menu displays only statistics related to DR2000v; no underlying hosting virtual
machine platform information is available through this menu.

•

DR Series system alerts and events are applicable only to DR2000v; no underlying hosting virtual machine platform
alerts/events are handled.

•

Hardware Health is not displayed on the GUI for the DR2000v as this is managed via the hosting platform.

Hyervisor host NIC driver updates for VMQ
Before deploying the DR2000v, you may need to update certain hypervisor host NIC drivers to support the VMQ feature.
Check your Hypervisor host NIC feature list and update the driver to the latest version as needed.
For example, you should update the Broadcom NetXtreme I and NetXtreme II Ethernet adapter driver to 17.6.0 (or later)
to add VMQ support; otherwise, you might experience performance degradation during normal operations. Refer to the
following links for downloading:
•

Driver for NetXtreme I and NetXtreme II Ethernet adapter:
http://www.dell.com/support/home/us/en/19/Drivers/DriversDetails?
driverId=CYKKJ&osCode=MWS80&fileId=3197327398&languageCode=EN&categoryId=NI

•

F
irmware for NetXtreme I and NetXtreme II Ethernet adapter: http://www.dell.com/support/home/us/en/19/Drivers/
DriversDetails?driverId=P32M4&osCode=MWS80&fileId=3197328666&languageCode=EN&categoryId=NI

DR2000v NIC settings
The DR2000v is designed to work with two virtual NICs. Internally, the DR2000v bond’s both the NICs to be Transmit Load
Balancing (TLB), which requires the eth-0 MAC address for the ethernet traffic.
For the DR2000v appliance to work properly, you should ensure the following settings:
1.
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Ensure that the eth-0 NIC is always connected to a valid Hypervisor Virtual Switch topology.

2.

Ensure that eth-0 line is always up and running.

3.

Enabling the eth-1 is optional, but if you enable it:
a.

Ensure the virtual switch settings MAC address changes and Forged Transmits are set to Accept, if you are
planning to use eth-1 in an ESXi hypervisor environment.

b.

Ensure the eth-1 interface is not connected if you do not have the administrator privileges.

4.

If you are making any network setting changes on your hypervisor, execute the stats –network CLI command
to list all the NIC ports status, especially with the Rx/Tx counts.

5.

If the eth-1 “Rx” counters are not getting incremented, but the “Tx” counters are getting incremented, then you
might have a problem with your switch settings, where the return traffic is getting dropped by your Hypervisor
vSwitch. To resolve this, see Step 3 above.

Setting up the license for the DR2000v
NOTE: If you will be deploying a trial version of the DR2000v, see the topic “Deploying the Dell DR2000v Trial
Version” later in this guide for detailed instructions.
Before you begin to deploy the DR2000v, you must install the permanent license onto a DR Series hardware system to
which the DR2000v will register. After the DR2000v is successfully deployed and booted for the first time, it will register
to this physical DR Series system. For more information about licensing, see the topic, “Specifications and Usage Notes
for the DR2000v ” in this document. For more information about licensing limits for the DR2000v, refer to the Dell DR
Series Interoperability Guide.
To install the permanent license onto the physical DR Series system with the license file e-mailed to you from Dell,
complete the following steps:
1.

Log on to the DR Series hardware appliance to which the DR2000v will register.

2.

In the GUI of the DR Series hardware system, navigate Support → License.
The License File Location field is displayed.

3.

In the License file location, click Browse to choose the DR2000v license file.
After you choose the license file, the License page displays the license file location and registered license
information.

4.

Click Install License.
The license is installed successfully, and the License page displays a successful notification with the registered
license information.
NOTE: This is a one-time licensing process for your DR2000v.

5.

You can now proceed with the deployment of the DR2000v.
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Deploying the Dell DR2000v on VMware ESXi

3

This chapter provides information about deploying the Dell DR2000v on VMware ESXi.
For detailed information about supported VMware ESXi versions, platform and license limits, virtual infrastructure and
memory requirements, and other information, see the Dell DR Series System Interoperability Guide.
The deployment process comprises the following tasks:
1.

Deployment of the DR2000v via one of the following:
•

Using the vSphere Client

•

Using the vSphere Web Client
NOTE: The security policy for vSwitches in VMware environments should be configured to allow MAC
Address Changes, this can be achieved by enabling the Allow MAC Address changes and Forged Transmits
option in the Layer-2 security policies of the vSphere vSwitches.

To edit the Layer 2 security policies of vSphere vSwitches, navigate to Security Policy settings and set the value for
the MAC Address Changes and Forged Transmits to Accept. For more information about security, see the vSphere
Security documentation.
2.

Setting up and Configuring the DR2000v

3.

Registering the DR2000v with a Physical DR Series System

Deploying DR2000v using vSphere Client
The following instructions describe the steps for deploying Dell DR2000v on VMware ESXi using the vSphere client.
1.

Acquire the DR2000v installation package and store it on your system or a network location. This package is in
VMware ESXi ova format.

2.

Launch the vSphere client, and log on to the vCenter server or the ESX host.( If you are using ESXi version 5.5, use
the Web client, since the vSphere client does not work with 5.5. See the topic, “Deploying DR2000v using the
vSphere Web Client,” for more information about deploying using the Web client.)

3.

In the vCenter management console, highlight the ESX host that will be hosting the VM, and then select File >
Deploy OVF Template.

4.

In the Deploy OVF Template - Source dialog box, click Browse.

5.

Browse to the location of the DR2000v .ova package on your system or network, select it, and click Open.

6.

In the Deploy OVF Template - Source window, click Next.

7.

In the Deploy OVF Template - OVF Template Details dialog box, click Next.

8.

In the Deploy OVF Template - Name and Location dialog box, enter the Virtual Machine (VM) name and click Next.

9.

In the Deploy OVF Template – Storage dialog box, choose a data store that meets the storage space requirement
(with minimum free space of at least the size the of the DR2000v system), and then click Next.

10. In the Deploy OVF Template - Disk Format dialog box, choose a storage provisioning method, and then click Next.
Note that selecting thin provisioning will require the space to be allocated as needed and may result in additional
performance impact.
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11. In the Deploy OVF Template — Ready to Complete dialog box, review the deployment information, select Power on
after deployment, and click Finish.
If the network setting does not default to the network you want, you might have to edit the network mapping after
this setup.
A dialog box appears to show progress of the deployment process.
12. In the Deployment Completed Successfully dialog box, click Close.
The DR2000v will boot up. (It takes approximately 3-5 minutes to self-extract the installation package and install all
of the components.)
13. Proceed with the initial setup and configuration of the DR2000v. Refer to the topic, “Setting up and Configuring the
DR2000v,” for instructions.

Deploying the DR2000v using the vSphere Web Client
The following instructions describe the steps for deploying Dell DR2000v on VMware ESXi using the vSphere web client.
1.

Acquire the DR2000v installation package and store it on your system or a network location. This package is in
VMware ESXi ova format.

2.

Launch and log on to the vSphere Web Client.

3.

Right-click the ESXi host that will host the DR2000v, and select Deploy OVF Template.

4.

In the Deploy OVF Template - Source window, click Browse to locate the DR2000v .ova template on your system or
network location, and click Open.

5.

Click Next to proceed.

6.

Review details in the Deploy OVF Template dialog box, and then click Next to proceed.

7.

In the Deploy OVF Template – Select Name and Folder dialog box, enter a Name for the virtual machine and select
the folder that hosts it, and then click Next to proceed.

8.

In the Deploy OVF Template – Select Storage dialog box, select the virtual disk format and the destination
datastore, and then click Next to proceed. You must choose a data store that meets the storage space requirement
(with minimum free space of at least the size the of the DR2000v system).
Selecting Thick Provision Lazy Zeroed will result in ESX Physical CPU Usage until the storage is allocated and
zeroed. Selecting Thin Provision will result in fragmented disks because the storage is provisioned as required.

9.

In the Deploy OVF Template - Setup Networks dialog box, configure the networks that the deployed template should
use, and click Next to proceed.

10. In the Deploy OVF Template — Ready to Complete dialog box, review the settings, select Power on after
deployment, and click Finish.
A dialog box appears to show progress of the deployment process.
11. In the Deployment Completed Successfully dialog box, click Close.
The DR2000v will boot up. (It takes approximately 3-5 minutes to self-extract the installation package and install all
of the components.)
12. Proceed with the initial setup and configuration of the DR2000v. Refer to the topic, “Setting up and Configuring the
DR2000v,” for instructions.
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4

Deploying the Dell DR2000v On Microsoft HyperV
This chapter provides information about deploying the Dell DR2000v on Microsoft Hyper-V.
For detailed information about supported Microsoft Hyper-V versions, platform and license limits, virtual infrastructure
and memory requirements, and other information, see the Dell DR Series System Interoperability Guide.
Before you begin the deployment process, ensure you have met the prerequisites described in the topic, Prerequisites
for the Dell DR2000v on Microsoft Hyper-V.
The deployment process comprises the following tasks:
1.

Deploying the DR2000v on one of the following:
•

On a local Hyper-V Host

•

On a remote Hyper-V Host

2.

Setting up and configuring the DR2000v

3.

Registering the DR2000v with a physical DR Series system
NOTE: As Microsoft only supports OVF format on system center Virtual Machine Manager. Using the Power Shell
scripts, the Dell DR2000v appliance’s deployment for the Hyper-V infrastructure is made easier, and the procedure
for creating virtual appliance with required settings is automated.

Prerequisites for deploying the Dell DR2000v in Microsoft Hyper-V
environments
For any DR2000v deployment the first step is to install the DR2000v license within an associated DR appliance. For more
information, see topic “Setting Up License for The DR2000v” in this document.
NOTE: These prerequisites are applicable to Microsoft Windows 2008 R2, 2012, and 2012 R2 Hyper- V
environments.
To deploy the Dell DR2000v on Microsoft Hyper-V and to use the DR2000v Hyper-V cmdlets, ensure that the following
prerequisites are met. For more information about the available DR2000v Hyper-V cmdlets, see the topic, “Using the
Suppported cmdlets for DR2000v for Hyper-V” in this document.
1.

Required User Privileges:
You must have administrator privileges or you must be a member of the administrator’s group

2.

Extract the downloaded DR2000v installation package on the Hyper-V host to access its files. It may take couple of
seconds for the files to be extracted. Before executing the Hyper-V installation process the following software prerequisites are required:
NOTE: This software is easily accessible from the Pre-Requisites folder. The pre-requisite file names may
change due to different DR2000V OS versions release and also other updates may be required.
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•

Installing .NET Framework 4.5
NOTE: For convenience both online and offline version of .NET 4.5 is available along with the .NET
security update packages. For this deployment use the .NET Framework 4.5.1 offline full install option
along with the two security update file of .NET.

•

Installing Windows PowerShell 4.0
Windows PowerShell 4.0 is part of the Windows Management Framework 4.0. Refer to the following link for
more information: http://www.microsoft.com/en-us/download/details.aspx?id=40855.

•

Installing Windows Remote Management (WinRM) v2.0
WinRM is the Microsoft implementation of the WS-Management Protocol. It uses Simple Object Access
Protocol (SOAP) over HTTP and HTTPS. For remote operations, port 5985 must be enabled on the Windows
Firewall for remote management on the target server. Refer to the following links for more information:
–

msdn.microsoft.com/en-us/library/aa384372(v=vs.85).aspx

–

http://blogs.technet.com/b/askperf/archive/2010/09/24/an-introduction-to-winrm-basics.aspx

Additional prerequisites for deploying the Dell DR2000v in Microsoft Windows 2008 R2
Hyper- V environment
Installing PowerShell Management Library for Hyper-V from Codeplex
This prerequisite is an Open Source project that provides a PowerShell management library for Hyper-V. It is based on
Microsoft Public License (MS-PL). You can download the binaries from the following location: https://
pshyperv.codeplex.com/releases.
•

Download the R2 SP1 version and save in the PreRequisites directory.

•

This product is not signed hence the PowerShell Execution Policy has to be set to Unrestricted. To do so, enter the
following command in PowerShell with elevated privileges: Set-ExecutionPolicy Unrestricted.

•

Press y to change the execution policy.

•

Reboot the server.

Once you have extracted the content of PsHyperV.zip, you need to unblock the content because Windows attempts to
block scripts downloaded from the Internet. To unblock the content using Windows Explorer:
1.

Open Windows Explorer, and navigate to the temporary HyperV folder.

2.

Right-click the first file in the folder and select Properties.

3.

When the file properties is displayed, click Unblock and OK. Repeat this to unblock all the files in the folder.

4.

After all the files are unblocked, move the folder HyperV to %WINDIR%\System32\WindowsPowerShell
\v1.0\Modules\ location.

5.

Import the modules from this library by executing the following PowerShell commands:
•

Get-Module -ListAvailable -Name HyperV

•

Import-Module -Name HyperV -WarningAction SilentlyContinue
NOTE: The output displayed in red is normal.

•

Get-Module -Name HyperV
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Additional prerequisites for deploying the Dell DR2000v in Microsoft Windows 2012 and
2012 R2 Hyper- V environment
Installing the Hyper-V Management Tools
This prerequisite is a Windows feature that contains a PowerShell extension to manage Hyper-V servers on Windows
2012 and 2012 R2 systems. Using PowerShell install this feature, enter the following commands with elevated privileges:
•

Install-WindowsFeature Hyper-V-Tools – This command enables Windows to administer Hyper-V.

•

Install-WindowsFeature Hyper-V-PowerShell – This command installs additional PowerShell
commands specialized for Hyper-V.

•

Set-ExecutionPolicy AllSigned – This command allows scripts signed by a trusted publisher to be run
on Windows server..

Install the digital certificate:
1.

Open Windows Explorer and navigate to DELL-DR2000v.dll file found in the bin directory of downloaded Hyper-V
package.

2.

Right-click the DELL-DR2000v.dll file and click Properties.

3.

On the Properties windows go to Digital Signatures → Details → View Certificate.

4.

On certificate windows, click Install Certificate → select On local Machine → Next and place it under Trusted
Publishers certificate store.

5.

Click OK → Next → Finish.

After the pre-requisites are complete, we are ready to deploy the DR2000v on local Hyper-v host. For more information,
see the topic “Deploying DR2000v on a Local Hyper-V Host”.

Deploying DR2000v on a local Microsoft Hyper-V host
NOTE: Ensure all the pre-requisites are complete before deploying the Dell DR2000v on a local Hyper-V host. For
more information, see the topic, “Prerequisites for deploying the Dell DR2000v in Microsoft Hyper-V
environments.”
NOTE: These deployment steps are applicable to Windows 2008 R2, 2012, and 2012 R2 Hyper-V hosts.
To deploy the Dell DR2000v on a local Hyper-V host:
1.

Run the Dell DR2000v command script from the install package.
A command line deployment wizard is displayed with the following options:

2.

a.

LOCAL

b.

REMOTE

c.

CONTROL PANEL

Type option ‘a’ for local deployment and press <Enter>.
The following ACTIONS are displayed:
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•

Deploy

•

Start

•

Stop

•

Delete

•

Repair

3.

Type action ‘1’ to deploy and press <Enter>.

4.

Type the appropriate DR2000v Hyper-V name and press <Enter>.
The following options to select storage size are displayed:
a.

1TB Data Storage Size

b.

2TB Data Storage Size

c.

4TB Data Storage Size
NOTE: Windows 2008 R2 version of the DR2000v does not offer 4TB data storage option.

5.

Type option ‘a’, ‘b’, or ‘c’ as appropriate and press <Enter>.
The DR2000v Hyper virtual machine code is now deployed and this process will take approximately 2–3 minutes. A
message is displayed showing the deployment progress, that is creating of new DR2000v template, processing the
DR2000v image, and populating the virtual machine with DR2000v configurations. A message appears when the
deployment has completed successfully

6.

When prompted to deploy another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press <Enter>.
The Local Deployment menu is displayed again.

7.

Type option ‘2’ and press <Enter> to start the DR2000v virtual machine to self extract the installation packages and
install all the DR2000v components.

8.

Enter the name of the DR2000v virtual appliance to start.

9.

When prompted to start another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press <Enter>.
The Local Deployment menu is displayed again.

10. Next launch Hyper-V Manager. Navigate to Start Menu → Administrative Tools → Hyper-V Manager.
The Hyper-V Manager window is displayed.
11. Select the host where DR2000v VM resides.
12. Right-click the DR2000v VM and select Connect to view the installation process
Depending on your system resources, it may take 10 - 20 minutes to self extract installation packages and
components.
13. After installation, proceed with the initial setup and configuration of the DR2000v as described in the topic,
“Configuring the DR2000v” in this guide.

Prerequisites for deploying the Dell DR2000v on a remote Hyper-V
host
For any DR2000v deployment, the first step is to install the DR2000v license on an associated DR Series system
appliance. For more information, see the topic “Setting Up the License for the DR2000v.”
Ensure that the following prerequisites are met before deploying the Dell DR2000v on a remote Hyper-V host:
1.

Both local and remote hosts/servers must have similar operating systems. For example, you cannot deploy a
DR2000v with a Windows 2008 R2 host to a Windows 2012 R2 server.

2.

Ensure that enough space is available on the remote machine before you start to deploy the DR2000v.

3.

Ensure that the following software requirements are included in both local and remote server/hosts:
•

.NET Framework 4.5

•

Windows PowerShell 4.0

•

Windows Remote Management (WinRM) v2.0
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4.

Ensure you have administrator privileges or you must be a member of the administrator’s group.

5.

Extract the downloaded DR2000v installation package on the Hyper-V host to access its files. It may take a couple
of seconds for the files to be extracted. Before executing the Hyper-V installation process, the software prerequisites are to be met.
NOTE: This software is easily accessible from the Pre-Requisites folder. The prerequisite file names may
change due to different DR2000v OS versions and also other updates may be required.
NOTE: For your convenience, both online and offline versions of .NET 4.5 are available with the .NET security
update files and Microsoft Management Framework 4.0 package.

6.

7.

Ensure that the following Windows commands are run on both local and remote hosts:
•

Install-WindowsFeature Hyper-V-Tools – This command enables Windows to administer HyperV.

•

Install-WindowsFeature Hyper-V-PowerShell – This command installs additional PowerShell
commands specialized for Hyper-V.

•

Set-ExecutionPolicy AllSigned – This command allows scripts signed by a trusted publisher to be
run on a Windows server.

You can run commands on one or hundreds of computers with the following single PowerShell command
syntax:Invoke-command —computername server01, server02, —scriptblock {commandto-run}. For more information on Invoke command, go to technet.microsoft.com/en-us/library/dd347578.aspx.
Use PowerShell to issue the three commands prerequisites to both local and remote systems, for example:

8.

•

Invoke-command —computername localserver01, server02, server03 –
scriptblock {install-WindowsFeature Hyper-V-Tools}

•

Invoke-command —computername localserver01, server02, server03 –
scriptblock {install-WindowsFeature Hyper-V-PowerShell}

•

Invoke-command —computername localserver01, server02, server03 –
scriptblock {Set-ExecutionPolicy Allsigned -Force}

Install the digital certificate using the Certificate Import Wizard:
a.

Open Windows Explorer and navigate to the DELL-DR2000v.dll file in the bin directory of the downloaded
DR2000v package.

b.

Right-click the DELL-DR2000v.dll file and click Properties.

c.

On the Properties windows, go to Digital Signatures → Details → View Certificate.

d.

On certificate windows, click Install Certificate → select On local Machine → Next and place it under Trust
Root Certification Authorities and Enterprise Trust certificate stores.

e.

Click OK → Next → Finish.

After the prerequisites have been met and drive capacity requirements are changed, you are ready to deploy the
DR2000v on a remote Hyper-v host. For more information, see the topic “Deploying DR2000v on a Remote Hyper-V Host”.

Changing the storage paths for Hyper-V deployment
The capacity requirements of the DR2000v are beyond 200GB. For example, if a 2TB DR2000v is to be deployed a 2.2TB
storage capacity will be required.
If an alternate storage location is required for the DR2000v virtual appliance due to capacity limitations or for other
reasons, the remote Hyper-V host Virtual hard disks and Virtual machine paths must be changed before the DR2000v is
deployed.
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To change the storage paths:
1.

Log on and connect to the remote machine using Remote Desktop Protocol (RDP) using the following command:
mstsc /v:<remote server IP address> .
For example: mstsc /v:127.0.0.1.

2.

Open the file manager and identify the volume that has free capacity for DR2000v deployment.

3.

Create a folder in this location.

4.

With the storage needs identified lets change the Hyper-V virtual machine storage locations. From local machine,
navigate Start Menu → Administrative Tools → Hyper-V Manager.
The Hyper-V Manager window is displayed.

5.

Connect to the host where the DR2000v will be deployed.

6.

Right-click the host and select Hyper-V settings option.
The Hyper-V settings window is displayed.

7.

Change both Virtual hard disks and Virtual machine path settings with the same new path and click OK.

The DR2000v Virtual machine is ready to be deployed.

Deploying the DR2000v on a Remote Hyper-V Host
NOTE: Ensure all the pre-requisites are complete before deploying the Dell DR2000v on a remote Hyper-V host. For
more information, see topic “Prerequisites for deploying Dell DR2000v on a remote Hyper-V host.”
NOTE: For remote deployments you must access the DR2000v deployment files using Universal Naming Convention
(UNC) path names and not mapped drive shares. The C: drive is the default share, so you should place the DR2000v
deployment files on the local machine.
1.

From the local machine, access the DR2000v deployment package using a UNC path name.

2.

Run the Dell DR2000v command script from the install package using the UNC path name.
A command line deployment wizard is displayed with the following options:
a.

LOCAL

b.

REMOTE

c.

CONTROL PANEL

3.

Type option ‘b’ for remote deployment and press <Enter>.

4.

Type the remote hostname or fully qualified domain name (FQDN) of the remote host and press <Enter>.

5.

Type the domain\user name for an authorized user of the remote host and press <Enter>.

6.

Type the password for this user and press <Enter>.

You will be prompted to enter the remote hostname and user credentials for accessing it.

The following Remote Deployment menu of actions is displayed:
•

Deploy

•

Start

•

Stop

•

Delete

•

Repair

7.

Type action ‘1’ to deploy and press <Enter>.

8.

Type the appropriate DR2000v Hyper-V name and press <Enter>.
The following options to select storage size are displayed:
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9.

a.

1TB Data Storage Size

b.

2TB Data Storage Size

c.

4TB Data Storage Size

Type option ‘a’, ‘b’, or ‘c’ as appropriate and press <Enter>.
The DR2000v Hyper virtual machine code is now deployed and this process will take approximately 2–3 minutes. A
message is displayed showing the deployment progress, that is creating of new DR2000v template, processing the
DR2000v image, and populating the virtual machine with DR2000v configurations. A message is displayed when the
deployment has completed successfully

10. When prompted to deploy another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press <Enter>.
The Deployment menu is displayed again.
NOTE: Before any remotely deployed DR2000v virtual appliance can be started, its virtual network adapters
need to be manually connected to a virtual switch.
11. Open local machine Hyper-V Manager. Navigate to Start Menu → Administrative Tools → Hyper-V Manager.
The Hyper-V Manager window is displayed.
12. Right-click Hyper-V Manager and select Connect to Server.
13. In Select Computer window, enter the name of the remote Hyper-V host that the DR2000v was remotely deployed
to.
14. Right-click the DR2000v virtual appliance and click Settings.
15. On the Settings window, click the NIC0 hardware object and choose the Virtual Switch to connect, repeat this step
for NIC1 and click OK to apply these settings.
16. Right-click the DR2000v virtual appliance and click Start to self extract the installation packages and install other
components.
17. Right-click the DR2000v virtual appliance again and select Connect to view the installation process
Depending on your system resources, it may take 10 - 20 minutes to self extract installation packages and
components.
18. After installation, proceed with the initial setup and configuration of the DR2000v as described in the topic,
“Configuring the DR2000v,” in this guide.
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5

Using the Supported cmdlets for the DR2000v for
Hyper-V

The supported cmdlets for the DR2000v for Hyper-V include capabilities for creating a new DR2000v as well as shutting
down, restoring, and removing a DR2000v.
The supported cmdlets are included in the binary modules: DELL-DR2000v.dll, and DELL-DR2000v. psd1. The .dll and .psd1
files are included in the uncompressed installation package under the “bin” folder.
To use these cmdlets, you must ensure the prerequisites have been met for Hyper-V as described in the topic,
“Prerequisites for the Dell DR2000v on Microsoft Hyper-V.”
Refer to the following topics for syntax details for using these cmdlets.
•

New-DR2000v

•

Remove-DR2000v

•

Repair-DR2000v

•

Start-DR2000v

•

Stop-DR2000v

New-DR2000v
Purpose
To create a new DR2000v virtual machine.

Syntax
New-DR2000v -Name <DR2000v name> -Image <absolute path to DR2000v Image zip> Size <size of the image> [-ComputerName <VMHost Name>] [-UserName] <username> Password <password>]

Parameters
•

Name: Specify the DR2000v name.

•

Image: Specify the UNC path location of the DR2000v base image file. In PowerShell, this will provide the UNC path
$env:DR_ImagePath. For example:
New-DR2000v -Name DR2000v-New -Image $env:DR_ImagePath

•

Size: Specify the size of the image with one of the following values: 1TB, 2TB, or 4TB. (Note that 4TB is only available
for Microsoft Hyper—V 2012 and Microsoft Hyper–V 2012 R2.)

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
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–
•

UserName: Specify user name.
–

•

Optional parameter. If not specified, the local host name will be used.

Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
–

Optional parameter. If not specified, cmdlet runs in current user context.

Remove-DR2000v
Purpose
To delete the DR2000v virtual machine.

Syntax
Remove-DR2000v –Name <DR2000v Name> -ComputerName <VMHost Name>] [-UserName
<username> -Password <password>

Parameters
•

Name: Specify the DR2000v name.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
–

•

UserName: Specify user name.
–

•

Optional parameter. If not specified, the local host name will be used.

Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
–

Optional parameter. If not specified, cmdlet runs in current user context.

Repair-DR2000v
Purpose
To restore the DR2000v operating system (OS) to the original firmware level, without impacting stored deduped data.
(This operation is equivalent to using the Restore Manager on a physical DR Series system.)

Syntax
Repair-DR2000v –Name <DR2000v Name> -Image <absolute path to DR2000v Image zip>
[-ComputerName <VMHost Name>] [-UserName <username> -Password <password>]

Parameters
•

Name: Specify the DR2000v name.

•

Image: Specify the UNC path location of the DR2000v base image file.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
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–
•

UserName: Specify user name.
–

•

Optional parameter. If not specified, the local host name will be used.

Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
–

Optional parameter. If not specified, cmdlet runs in current user context.

Start-DR2000v
Purpose
To start a DR2000v virtual machine.

Syntax
Start-DR2000v —Name <DR2000v Name> —SwitchName_NIC0 <switch name>
_SwitchName_NIC1 <switch name> [—ComputerName <VM Host Name>] [—UserName
<username> —Password <password>]

Parameters
•

Name: Specify the DR2000v name.

•

SwitchName_NICx: Specify the virtual switch for the virtual NICs.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
–

•

UserName: Specify user name.
–

•

Optional parameter. If not specified, the local host name will be used.

Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
–

Optional parameter. If not specified, cmdlet runs in current user context.

Stop-DR2000v
Purpose
To shut down the virtual machine gracefully.

Syntax
Stop-DR2000v –Name <DR2000v Name> [-ComputerName <VMHost Name>] [-UserName
<username> -Password <password>]

Parameters
•

Name: Specify the DR2000v name.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
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–
•

UserName: Specify user name.
–

•

Optional parameter. If not specified, the local host name will be used.

Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
–

Optional parameter. If not specified, cmdlet runs in current user context.
NOTE: The Start-DR2000v and Stop-DR2000v are Power Shell Cmdlets that must be added into your
scripting infrastructure for management.
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Configuring the Dell DR2000v

6

This chapter describes how to set up and configure the Dell DR2000v for the first time, including registration with a
physical DR Series system. Refer to the following topics.
•

Setting up and Configuring the DR2000v

•

Registering the DR2000v with a Physical DR Series System

Setting up and Configuring the DR2000v for the first time
1.

After deploying the DR2000v, wait for the virtual appliance to boot completely. It takes approximately 10-20 minutes
to self-extract the installation package and all the components.

2.

Log in to the DR2000v virtual machine (VM) console using the default Username: administrator and Password:
St0r@ge!.
The Initial System Configuration Wizard is displayed.

3.

On Initial System Configuration Wizard screen, type yes and press <Enter> to finish the Initial System Configuration
on network settings.

4.

Follow and type through the wizard to configure the required network entries and confirm the configuration
settings.
•

If DHCP configuration is used all the entries are done automatically.

•

If Static IP configuration is used all of the entries must be entered manually.

After the required network settings are configured, the VM will run the initial configuration and may take up to 3-4
minutes to complete.
After successful installation and configuration of the DR2000v, the DR2000v Registration screen is displayed.
5.

To register the DR2000v with physical DR Series appliances:
•

from the command line, type yes and press <Enter> on the DR2000v Registration screen.

•

from the GUI, type no and press <Enter> on the DR2000v Registration screen. For more information, see topic
“ Registering the DR2000v with a Physical DR Series System” in this document.
NOTE: Registering the DR2000v appliance fails and an error is displayed if the license has not been installed
onto the physical DR appliance. Each DR2000v appliance comes with a built-in, 30-day temporary license.

Registering the DR2000v with a Physical DR Series System
After successfully installing and configuring the DR2000v for the first time, it must be registered to a physical DR system.
If you did not complete the DR2000v registration through the command line during the initial configuration then manually
register the DR2000v with a physical DR system using the GUI.
1.

Open a web browser and enter the DR2000v IP address to access management console.

2.

Access the DR2000v GUI management interface using the default login credentials, Username: administrator,
Password: St0r@ge!
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The Customer Registration and Notification page is displayed.
3.

If you are accessing the management console for the first time, you must enter registration information and click
Confirm.
An Initial Software Upgrade page is displayed for you to verify that you have the latest available software updates.

4.

To register the DR2000v, navigate toSupport → License section of the management console.
The License page is displayed.

5.

On the License page click Register.
Register Window is displayed.

6.

Type the IP Address or hostname of the physical DR and other required details for the DR2000v license server and
click Register.
The DR2000v is registered.
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7

Deploying and configuring the Dell DR2000v trial
version
This chapter describes the steps for deploying and configuring the Dell DR2000v 30–day trial.
NOTE: The DR2000V trial version does not require a license to be installed for use. If a registration request
message occurs during your 30-day trial, you can safely ignore the message.
NOTE:

Converting from trial to production: A DR2000v trial version can be converted to a production system when:
•

A DR2000v license is purchased and installed in a physical DR Series hardware system.

•

The former DR2000v trial version is registered to the license installed in a physical DR Series hardware
system.

•

The registration of a DR2000v during a 30–day evaluation is possible if the evaluation time has not expired.

Deploying a DR2000v trial version in VMware environments
The following instructions describe the steps for deploying the Dell DR2000v trial in a VMware environment by using the
vSphere or Web client.
1.

Acquire the DR2000v trial installation package and store it on your system or a network location. This package is in
VMware ESXi ova format.
To download the trial version, visit the following link: http://software.dell.com/products/dr2000v-virtual-backupappliance/software-downloads.aspx.

2.

Using vSphere Client or Web Client, deploy the downloaded OVF template as described earlier in this document.

Deploying a DR2000v trial version in Microsoft Hyper-V
environments
To deploy the trial Dell DR2000v in a Microsoft Hyper-V environment, follow these steps:
1.

Download the DR2000v trial version and store it on your system or network location.
To download the trial version, visit the following link: http://software.dell.com/products/dr2000v-virtual-backupappliance/software-downloads.aspx.

2.

When you have obtained the DR2000v trial installation package, extract the downloaded DR2000v trial installation
package to the Hyper-V host.

3.

Implement the prerequisite software, commands, and digital certificates that are outlined in the topic,
“Prerequisites for deploying the Dell DR2000v in Microsoft Hyper-V environments,” previously in this guide.
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NOTE: Some of the prerequisite files are conveniently located in the extracted DR2000v installation package
within the prerequisites folder. Additionally, Windows 2008R2 Hyper-V has a specific set of requirements you
should ensure are met as described in the earlier topic in this guide, “Additional prerequisites for deploying
the Dell DR2000v in Microsoft Windows 2008 R2 Hyper-V environment.” Windows 2012 and 2012R2 has a
specific set of requirements as described in the topic in this guide, “Additional prerequisites for deploying
the Dell DR2000v in Microsoft Windows 2012 and 2012R2 Hyper-V environment.”
4.

Refer to the topic “Deploying a DR2000v into a local Microsoft Hyper-V Host” earlier in this document, and follow
the instructions for deployment. When prompted to select a storage size, select 2TB Data storage size, which is
supported for the trial version.

Configuring a DR2000v trial version
The following instructions describe the steps for configuring the Dell DR2000v trial for use.
1.

Launch and follow the steps of the DR2000v Initial System Configuration Wizard:
a. Power up the DR2000v and open the virtual machine console. It may take 5-10 minutes to self-extract the
installation packages and install the components.
b. Log into the DR2000v using the default credentials. (username: administrator and password:St0r@ge!)
c. Proceed through the first-time Initial System Configuration Wizard, providing the proper network settings for
use within your environment.
d. When prompted to register, enter eval (No licensing or registration is necessary).

2.

Launch the DR2000v trial GUI and follow the initialization steps:
a. In a Web browser, launch the DR2000v trial version GUI using the IP address, logging in with the default
credentials (username: administrator and password:St0r@ge!).
b. Follow the one-time DR2000v initialization steps. (You can click Skip or enter your contact information on the
Customer Registration and Notification page.)
c. (Optional) On the Initial Software Upgrade page, update the DR2000v to the latest version of the DR Series
system software.
d. If the Virtual machine Update Manager is more recent than what the DR2000v is running, download it at: Virtual
Machine Update Manager.
The deployment of the DR2000v Trial version is complete.
e. If you want to update the DR2000v to the latest version, in the left navigation area of the GUI, select Software
Upgrade. Then, click Choose File, select the downloaded Virtual Machine Update Manager file downloaded
earlier, and click Start Upgrade.
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Getting Help

8

For more information about what you can attempt to resolve yourself or to get technical assistance from Dell for the DR
Series system, see the topics below, “Before Contacting Dell Support,” and “Contacting Dell.”

Before Contacting Dell Support
If you encounter an error condition or operational issue, Dell recommends that you first attempt to see if you can resolve
it using the supporting Dell DR Series system documentation before you make an attempt to contact Dell Support for
technical assistance.
To help isolate or diagnose any basic issues that you may encounter with the Dell DR Series system, Dell recommends
that you perform the following tasks:
•

Refer to the Dell DR Series System Administrator Guide to verify if it contains information that can explain or resolve
your issue. See Chapter 9, “Troubleshooting and Maintenance”.

•

Refer to the Dell DR Series System Command Line Reference Guide to verify if it contains information that can
explain or resolve your issue.

•

Read the latest set of Dell DR Series System Release Notes to verify if they contain any information that can explain
or resolve your issue.

•

Locate your Dell support account number and password, locate the Service Tag for your DR Series system,
understand your type of support account, and be ready to provide specific details about the system operations you
were performing.

•

Record the content of any status or error dialog messages that you received, and the sequence in which they were
displayed.

•

Generate a current version diagnostics file (or if this is not possible, locate your latest existing diagnostics file).
–

Using the DR Series system GUI, click Diagnostics → Generate to generate a diagnostics file.

–

Using the DR Series system CLI, at the system prompt, enter the command diagnostics --collect to generate a
diagnostics file. For more information, see the Dell DR Series System Command Line Reference Guide.
NOTE: For best results in addressing replication issues, you should generate diagnostics files on both DR Series
source and target systems as close in time as possible.
NOTE: Each generated diagnostics file bundle contains information to assist Dell Support with the most current
data about:
•

System alerts and events

•

System configuration status

•

System log files

•

System statistics for storage and replication containers

•

System hardware component status

Contacting Dell
NOTE: If you do not have an active Internet connection, you can find contact information on your purchase
invoice, packing slip, bill, or Dell product catalog.
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Dell provides several online and telephone-based support and service options. If you do not have an active Internet
connection, you can find contact information on your purchase invoice, packing slip, bill, or Dell product catalog.
Availability varies by country and product, and some services may not be available in your area. To contact Dell for
sales, technical support, or customer-service issues, go to dell.com/support.

Documentation feedback
Click the Feedback link in any of the Dell documentation pages, fill out the form, and click Submit to send your feedback.
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